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An Intro to Laser Scanning:  
From ReCap Pro to Revit to the Future 
Kyle Barker, AIA NCARB 
MERGE Architects, Inc. 

Learning Objectives 
Following this class attendees will be able to: 

- Describe the differences between Photogrammetry & LiDAR 
- Describe the process of using a laser scanner to capture existing conditions 
- Use ReCap Pro to navigate and edit a point cloud 
- Use point cloud data as part of an existing Revit workflow 
- Understand the benefits of point cloud data to the architectural delivery process 
- Think critically about the current & future uses of laser scanning 

Description 
3D laser scanning promises architects greater efficiencies and cost savings in the designing, building, 
and restoring of spaces. Yet, investing time and resources in mastering the technology has created fear, 
uncertainty, and doubt about the potential yield. This session will teach attendees the basics of 
scanning, and explore the latent possibilities of the technology. It will describe the differences between 
the most-common scanning technologies—photogrammetry and LIDAR; demonstrate the use of a 
commercial laser scanner; outline the basic ReCap Pro-to-Revit workflow; highlight the benefits of the 
technology in construction document delivery; and explore advanced uses for laser scanning, while 
imagining the future potential. 

Speaker 
Kyle Barker is an Associate at  MERGE Architects  in Boston where he leads academic, commercial and 
multi-family housing projects across the US. Previously, he was a Project Manager at  MASS Design 
Group  and a Designer at  Kennedy & Violich Architecture . 

Barker received his Master of Architecture from the MIT Department of Architecture where he was the 
recipient of the Alpha Rho Chi Medal, Rosemary D. Grimshaw Thesis Prep Award, Louis C. Rosenberg 
Travel Fellowship and three Departmental Merit Scholarships. He was a finalist for the 2017 Rotch 
Travelling Scholarship and the nationwide selection for the 2013 ZGF Architectural Scholarship. 

He has taught studio at the Boston Architectural College and workshops at MIT and served on awards 
juries for  Architizer  and the Massachusetts & Oklahoma chapters of the AIA. In 2012, he founded a 
freelance design practice,  Extra Work , to pursue his passions outside of work; with that, he has done 
work for Boston’s Emerald Necklace Conservancy, MIT, and private clients. 
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Photogrammetry & LIDAR 

  Photogrammetry  LIDAR 

Definition  Uses photography to measure distance 
between objects. Relies on multiple 
photos of the same subject matter 

Uses pulsing laser, rapidly spinning mirror 
and sensor to capture location of 
laser strikes 

Equipment  Camera  LIDAR Scanner (some incorporate 
traditional cameras and/or thermal 
cameras) 

Good for...  Organic subject matter 
Scenes with visual chaos 
Typically used for small objects - stuffed 

animals, statues - and large scale 
nature 

...anything 

Pros  Inexpensive (depending on camera used) 
Captures organic textures well 
Easy to learn 

Highly accurate (within 6 mm at a range 
of 10 m) 

Can “see through” foliage 
Works in low / no-light settings 
Geometry / texture agnostic 
Easy to learn 

Cons  Accuracy is dependent on capturer 
Has difficulty with grid-like patterns 
Has difficulty with large flat expanses 
Does not work in low / no-light 
Cannot “see through” foliage  
Does not capture information that can’t 

be seen by capturer  

Higher financial bar to entry 
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BLK360 Setup 
- The night before: 

- Charge the battery (4 to 8 hours for a full charge). 

- If you think you will be doing more than 40 scans, bring a back-up battery. 

- The day of: 

- Ensure tripod is fully extended / stable. 

- Ensure that BLK360 clicks into tripod, and is properly seated. 

- In windy settings, be mindful of the tripod toppling. 
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Best Practices for Scan Placement 
- While scanning, leave the room, or move around the scanner as it rotates, ensuring that 

you can see the button. (If you don’t, you will show up in the photography and/or the 
pointcloud, obscuring data.) 

- Wait for scan to finish before moving. The indicator will change to green to let you know 
it is ready to move. 

- Place scanner as far as possible from tall obstructions: the more it can bounce, the 
better. 

- Know that columns will create a blank, wedge-shaped area beyond. Make sure to cover 
this area with a separate scan. 

- Place scans approximately 10 feet apart. 

- If scanning multiple rooms, place the scanner in the doorway between spaces to ensure 
aid in registration. 
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ReCap for iPad Workflow 
The primary purpose of using ReCap on the iPad while scanning is to ensure comprehensive data 
capture in the field and to register scans as you go 

Scanning 
- To begin, “Create a New Project” in ReCap 

- Before scanning, review the settings. Here, you can: 

- Change the quality of the scan. The lower the quality, the faster the scan. 

- Select HDR. This is relevant in low-light or high-contrast settings. Note that it will slow 
your scan speed down. 

- Press “Capture” to start a scan. 

- Once it has begun transferring, you can move the scanner to the next location. (Again, the 
indicator light on the BLK360 will also turn green to let you know.) 
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Registering Scans 
- Once the second scan has finished transferring, it will auto-register the scans and give you a 

readout on the accuracy of the scan. 

- If the auto-registration fails, you can manually register by selecting three points in common 
between two scans. 

- You can use any two scans. 

- Select points on difference faces of the model (floor, wall, and ceiling for example). 

- Be as accurate as possible, but if you are within a few feet, that will suffice. 

ReCap for iPad Interface 
- Tap on a “mirror ball” to view the scan taken from that location. 

- Swipe to look around from a scan location. 

- You can monitor the coverage you’ve achieved via the “Map View.” 

- You can add notes and take dimensions in the field, as desired. 
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ReCap for Desktop Workflow 
The primary purpose of the ReCap for Desktop workflow is to remove extraneous data from the point 
cloud to clarify content and reduce the file size. It can also be used to visualize data and create 
annotations. 

Starting a New Project 
- Launch ReCap Pro. 

- Connect iPad to computer using thunderbolt cable. 

- Select "New Project." 

- Select "Transfer from Mobile Device." 

- If there are multiple projects on your iPad, select the one you’d like to import. 

- After the files have finished downloading to your computer, select “Index Scans.” 

- It will launch the ReCap App. 

Cleaning Up a Point Cloud 
- Point clouds require “cleaning,” a process of removing errant data.  

- The two primary forms of errant data are: 

- People: either passers-by or you, if you forget to move out of the way of the scanner 

- Spatial doubling: created by reflective surfaces 
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- To remove the offending points you need to have a viewing angle that allows you to select the 
points without accidentally selecting important information near them. 

- I begin by deleting the points outside of the space in question.  

- I do this by getting into a view where I can select the points without selecting content 
beyond them; this is typically done in an elevation or plan view.  

- I use the “Fence” tool and, once the points are highlighted, press “Delete.” 

- If you accidentally select a large batch of points, you can press “Esc” to deselect all. 

- Next I delete errant points inside the space.  

- To do this I open the “Project Navigator,” in the lower right corner, and determine which 
scan the points are on by turning off the scans one by one. This is done by clicking on 
the eye icon next to each one. 

- With only the scan requiring cleaning turned on, I navigate to a view with minimal data 
beyond, select the points using the “Fence” tool and press “Delete.” 

- Once you are finished removing points, turn back on the other scans; because of the 
overlapping data, the hole in the scan will be filled in by their data. 

- The file will save as a .rcp file. 
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ReCap to Revit Workflow 
The primary purpose of linking the ReCap file into Revit as a background is to reference it in building 
your existing conditions model. 

Disclaimer: This portion of the lesson assumes a basic knowledge of the Revit workflow. The internet is 
full of educational content, but I found this to be a useful primer:  https://autode.sk/2AxsGdg 

Linking a .rcp into Revit 
- Navigation to “Insert > Manage Links > Point Cloud > Add” and select the .rcp file from the 

location you saved it. 

- Move the .rcp file to the location of your choice within the Revit model.  

- I would recommend setting it’s zero elevation to the zero elevation of your model, and 
confirming that the .rcp’s North aligns with the True North of your Revit workspace. 

- You can use all of the typical Revit functions to move the .rcp: “Move,” “Rotate,” etc. 

- Once you are satisfied with its location, select the .rcp and “Pin” it to lock it in place. 

- The default behavior in Revit is for pinned items to highlight as you mouse over them. 
With point clouds, this requires a significant amount of processing power. To turn this 
off, disable “Select Pinned Elements” in the lower right corner of the interface.  
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Modeling Existing Conditions from the .rcp File 
- I treat the .rcp file like I would treat orthographic drawings, using the same workflow to build the 

Revit model. 

- I create a section (“View > Section”) from a moment with critical infrastructure and I create a floor 
plan (“View > Plan”). 

- From the section view, I add in the key building levels. For existing spaces I often add 
the following levels: 

- B.O. Deck 
- B.O. Structure 
- B.O. Sprinklers 
- T.O. Grade 
- T.O. Slab 

- From the plan view I add in the structural grids. (The relevancy of this depends on your 
project.) 

- From there I proceed with the typical Revit workflow, I add: 

- Walls & Columns 
- Floors 
- Ceilings 
- Doors & Windows 
- Any MEP-FP equipment that may cause conflicts (typically items at the lowest elevation 

in the space) 

- Once I have finished the basic model I navigate back to “Manage Links” and turn off the point 
cloud, but leave it attached.  

- This allows me to turn the model back on later when I need to confirm a dimension or 
look for potential conflicts with the existing conditions. 

- Turning off the model also frees up processing power. 

- It is possible from the “Visibility Graphics” menu to turn off scans individually or view 
them in different color modes. These settings can also be incorporated into View 
Templates. 
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Further Reading 
1. Atelier Bow Wow.  Graphic Anatomy: Atelier Bow-Wow.  Toto, 2007. 

A book of perspectival sections & plans of the architecture firm Atelier Bow Wow’s work. 

2. Barker, Kyle. “An Architect Explores 3D Laser Scanning.” Leica Geosystems, 
www.lasers.leica-geosystems.com/kyle-barker . 
A blog with step by step tutorials and commentary on my experience scanning with the BLK360. 

3. “Google Earth's Incredible 3D Imagery, Explained.” YouTube, Nat and Friends, 18 Apr. 2017, 
www.youtube.com/watch?v=suo_aUTUpps . 
A fascinating look at Google’s method for creating 3D-imagery in Google Earth. 

4. Lewis, Paul, et al.  Manual of Section.  Princeton Architectural Press, 2016. 
A book of perspectival sections of canonical modern & contemporary architecture by the 
architectural practice Lewis Tsurumaki Lewis. 

5. Lievendag, Nick. “The Beginners Guide to 3D Scanning & Photogrammetry on a Budget.” 3D 
Scan Expert, 27 Feb. 2018, 
www.3dscanexpert.com/beginners-guide-3d-scanning-photogrammetry/ . 
A description of photogrammetry and laser scanning; Nick writes in an accessible way that is 
useful to beginners and advanced users alike. 

6. Mayersen, Isaiah. “Apple Has Taken to Mapping San Francisco on Foot.” TechSpot, 14 Oct. 
2018,  www.techspot.com/news/76918-apple-has-taken-mapping-san-francisco-foot.html . 
Hot off the press! Apple is gathering data for Apple Maps via LIDAR backpacks in San Francisco. 

7. Nichols, Greg. “View the Pyramids of Ancient Egypt in This 360 Degree VR Capture.” ZDNet, 24 
July 2018, 
www.zdnet.com/article/view-pyramids-of-ancient-egypt-via-this-360-degree-vr-capture/ . 
The BLK360 was used to capture the Tomb of Nefertari, a site closed off to tourists for 
preservation reasons. 

8. O'Brien, William.  Room for Artifacts: The Architecture of WOJR.  Park Books, 2016. 
An early career overview of the work of the architectural practice WOJR with contributed essays. 

9. Prozzillo, Fred. “How 3D Technology Is Transforming Frank Lloyd Wright's Desert Laboratory - 
Icon Magazine.” Icon Magazine, 17 June 2018, 
www.iconeye.com/architecture/features/item/13046-how-3d-technology-is-transforming-frank-ll
oyd-wright-s-desert-laboratory . 
A look at the partnership between Leica & the Frank Lloyd Wright Foundation to scan Taliesin 
West with the BLK360. 

10. Spielberg, Steven, director.  Minority Report.  20th Century Fox, 2002. 
A movie based on a Philip K. Dick novel with inspiring interface design. 

11. Vobis, Yasmin. “Color Space.” ULTRAMODERNE, 2017,  www.ultramoderne.net/?p=27 . 
A description of Vobis’ Rome Prize work scanning Cathedrals in Italy. 
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12. Zhang, Michael. “Aerial Interior Photo of a Building Created by Stitching Hundreds of Photos.” 
PetaPixel, 28 Mar. 2012, 
www.petapixel.com/2012/03/28/aerial-interior-photo-of-a-building-created-by-stitching-hundred
s-of-photos/ 
An explanation of Beyer’s process for creating his “aerial interior” of Cornell’s Milstein Hall. 
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